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CORPORATE PROFILE

Micromeritics Instrument Corporation is the world’s leading supplier of high-performance systems
to characterize particles, powders and porous materials with a focus on physical properties,
chemical activity, and flow properties. Our technology portfolio includes: pycnometry, adsorption,
dynamic chemisorption, particle size and shape, intrusion porosimetry, powder rheology, and
activity testing of catalysts. The company has R&D and manufacturing sites in the USA, UK, and
Spain, and direct sales and service operations throughout the Americas, Europe, and Asia.
Micromeritics systems are the instruments-of-choice in more than 10,000 laboratories of the
world’s most innovative companies, prestigious government, and academic institutions. Our
world-class scientists and responsive support teams enable customer success by applying
Micromeritics technology to the most demanding applications. For more information, please visit
www.Micromeritics.com.
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CONTACT Us

Micromeritics Instrument Corporation
4356 Communications Drive
Norcross, GA/USA /30093-2901
Phone: 1-770-662-3636
Fax: 1-770-662-3696

www.Micromeritics.com

Instrument Service or Repair
Phone: 1-770-662-3666

International: Contact your local distributor or call 1-770-662-3666
Service.Helpdesk@Micromeritics.com

Micromeritics Application Support
Support@Micromeritics.com
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[M] micromeritics’ ErorMessages

ERROR MESSAGES

If the Action response indicates to contact a Micromeritics service representative, record the error
message, then make backup copies of any files involved in the operation.

Error Messages for Keypad on page 24

2420 Invalid defaults. Program will terminate.
Cause: The application .ini file is missing or invalid.
Action: Re-install the application from the installation media.

2421 Invalid file subsystem. Program will terminate.
Cause: The application could not read the default method files.

Action: Delete the default method files and restart the application

2432 Invalid response from MMI ‘FILE_READ’ request.
Cause: An internal processing and/or hardware error has occurred.

Action: Contact a Micromeritics service representative if this error message continues.

New entries have been found in this directory. Refresh the directory inform-

2433 ation?

Cause: Several analyzer files have been added to this directory by some function other
than the analysis application.

Action: Click Yes to update the directory information with data from each new file. This
operation may take a minute.

Click No to locate the file manually. This option may be feasible if a large number of
files have been copied into the directory and the file name is known.

2434 File [n] — Subset [n] wrote [n] bytes, expected [n] bytes.
Cause: An internal processing and/or hardware error has occurred.

Action: Contact your Micromeritics Service Representative.

2437 File name [n] does not exist.

2437 Overlay file [n] does not exist.
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2438

2448

2448

2448

2448

2448

2448

2448
2448
2448
2448

2448

2448

2448

Cause: Thefile selected in the report option does not exist.

Action: Enter an existing file specification, or select a file name from the list box.

Cannot open scheduling diagnostic data save file: [n].

Cause: Thefile necessary for Unit [n] > Diagnostics > Schedule Diagnostic Test

(...\Hardware\scheddiagtests.dat) could not be read. It is likely corrupted.

Action: Exit the application. Delete or rename the file mentioned in the error message and

restart the application . A new file will be created. Also ensure that the hardware dir-
ectory is not write-protected.

The export data file directory [n] cannot be used. Resetting to the installation
directory.

The reference file directory [n] cannot be used. Resetting to the installation dir-
ectory.

Default convert sample file directory [n] is invalid. Resetting to the installation
directory.

Default mass spectrometer file directory [n] is invalid. Resetting to the install-
ation directory.

Default parameter file directory [n] is invalid. Resetting to the installation dir-
ectory.

Problem diagnostic directory [n] is invalid. Resetting to the installation dir-
ectory.

User python script directory [n] is invalid. Resetting to the installation directory.
Default report directory [n] is invalid. Resetting to the installation directory.
Default sample file directory [n] is invalid. Resetting to the installation directory.
The SPC report directory [n] is invalid. Resetting to the installation directory.

The z-table file directory [n] cannot be used. Resetting to the installation dir-
ectory.

File directory [n] is invalid. Resetting to the installation directory.

Default script test file directory [n] is invalid. Resetting to the installation dir-
ectory.

Cause: Aworking directory specified in the .INI file is invalid, has been moved or deleted.

Action: The installation directory will be substituted. The next time a file is opened, use the

directories list to move to the correct directory.
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2449 This field does not contain a valid file specification.
Cause: Aninvalid file name was entered.

Action: See the description of file naming conventions in a Windows manual, then re-enter
the name.

2451 The specified folder does not exist.
Cause: Path entered in the file selector does not exist.

Action: Enter the correct file path, or browse for the correct file path.

The instrument is busy performing an operation of which this application is

2452 unaware. Do you want to cancel?

Cause: Theinstrumentis performing an operation which is not recognized by the
application.

Action: Click Yes to have the application cancel the operation. Click No to allow the oper-
ation to continue.

2456 Insufficient file handles available. Application cannot continue.
Cause: More than 50 files are open at the same time.

Action: Referto a Windows operating system manual then set the limit for open files to 50
or greater. Alternatively, close any unused open files.

An instrument is performing a critical operation. Wait a few moments before

2458 exiting the application.

Cause: An attempt was made to exit the application while the analyzer was performing a
critical operation. This operation must be completed before the application can be
exited.

Action: Wait a short time and attempt to exit the application again.

An instrument is busy. A delay in restarting this application could result in loss

2459 of new data. Continue with program exit?

Cause: An attempt was made to exit the application while an analysis was in progress.
While this is possible, the data collected when the application is inactive will not be
permanently recorded until the application is restarted. A power failure to the ana-
lyzer could cause some data to be lost. Continued data collection may also exhaust
the memory of the controller.
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Action: If not concerned with the potential for loss of data should a power failure occur, click
Yes to continue; otherwise, click No.

2460 Fatal Communications error on [n].

Cause: There was a fatal error in communication between the application and the software
in the analyzer. All displays for that analyzer will be closed.

Action: Ensure that the analyzer is connected to the computer on the communications port
configured in the Setup program. Stop and restart the analyzer application. Contact
your Micromeritics Service Representative.

2461 No instruments are in operation. This application will unconditionally terminate.

Cause: Atleast one analyzer must be active for the application to operate. The initialization
of all analyzers configured with the Setup program has failed. The application
stops.

Action A: Usually this message is preceded by another message giving the reason for the
analyzer ’s failure to initialize. Refer to the instructions for that message.

Action B: Ensure that the analyzer is attached to the computer on the communications port
configured with the Setup program. Verify that the analyzer's power switch is in the
ON position and that the light on the front panel is illuminated. Contact a Micro-
meritics service representative if this error message continues.

2477 [n] did not properly initialize.

Cause: The application was unable to initialize this analyzer. This is usually caused by one
of the conditions listed in the previous error messages.

Action: w Correct the problem indicated in the previous error message, then restart the

application.
® Run the Setup program and ensure that a valid port is specified; if not, specify a
valid one when prompted.

®= Reinstall the application, then restart the application.
® Contact a Micromeritics service representative if this error message continues.

2479 Cannot open [n] because it is a [n] file.

Cause: The file cannot be opened because it came from a different Micromeritics applic-
ation

Action: Select a different file.
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2480 File [n] cannot be analyzed. It is currently being edited.
Cause: An attempt was made to start an analysis using a file that is open for editing.

Action: Finish editing the file, save and close it, then start the analysis.

2481 Error accessing the sample information file [n].
Cause A: Anunexplained error prevented access to this file.
Action A: The hard disk drive may be corrupt. Run diagnostics.
Cause B: An attempt was made open a file that is already open, possibly minimized.
Action B: View the minimized icons, locate and maximize the file.
Cause C: A computer or network problem occurred.

Action C: Check the performance of the computer devices or network.

2482 File cannot be opened for writing.
Cause: An attempt was made to open a file currently being used.

Action: Locate the application using the file. In the Micromeritics application, use the Win-
dow menu item for a list of all open windows.

An analysis cannot be performed on [n]. It is open for editing and contains
errors.

2483

Cause: An attempt was made to use a sample file containing errors that is currently open.

Action: Go to the window containing the file, correct the errors, then save it.

The edit session for [n] must be saved before the analysis. Save changes and

2484 continue with the analysis?

Cause: An attempt was made to start an analysis using a file that contains unsaved
changes and is open for editing.

Action: Click Yes to save the changes, then proceed with the analysis. Click No to cancel
the analysis, then continue editing the sample file.

2485 Sample file [n] has an invalid status and cannot be used for this operation.
2485 The service test file has an invalid status and cannot be used for this analysis.
Cause: The selected file has a status other than No Analysis.

Action: Select afile, or create a new one and click Replace All to copy parameters from
the file originally selected.
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2486 Cannot construct [n] report type. Program will terminate.
Cause A: Full rights to the application folders and files is required.
Action A: Contact a system administrator to have full rights granted.
Cause B: Aninternal processing and/or hardware error has occurred.

Action B: Contact your Micromeritics Service Representative.

2488 File [n] cannot be opened. It is already in use.
2488 File [n] cannot be opened for editing.
Cause: The specified file is open for editing.

Action: Check the Window menu item to locate the other edit session or check if the file is
open in another application.

2489 File [n] cannot be opened for writing.
Cause A: The specified file in a Save As operation is open.

Action A: Select a different file for the Save As operation.

2491 Highlighted fields contain errors. Please correct the errors before closing.

Cause: The fields highlighted in red contain invalid entries. The window cannot be closed
until all errors are corrected.

Action: Check the entries, correct the errors, then close the window.

2492 This field’s entry is invalid.
2493 An entry is required for this field.
Cause: The highlighted field contains an invalid entry.

Action: Check the entry and correct the error.

2494 Value is out of the valid range.
2495 Enter a value between [n] and [n].
Cause: The entered value in the highlighted field is outside the valid range of values.

Action: Check the entry, then either enter or select an appropriate value. The valid range is
shown in the information bar.
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2496 Invalid number.
2497 This field contains an invalid character.
Cause: Aninvalid number (or character) was entered in the highlighted field.

Action: Check the entry, then either enter or select a valid number (or character).

2498 The requested change to the Sample’s status is invalid at this time.

Cause: Arequestto change the file status, for example, from automatically collected to
manually entered could not be done.

Action: Contact your Micromeritics Service Representative. Record the name of the same
file in which the problem occurred.

2499 Sequence number must contain at least 3 digits.

Cause: An attempt was made to enter a sequence number that did not contain at least
three digits.

Action: Enter a sequence number that contains at least three digits.

All sample file names that can be created using the sequence number pattern

2500 already exist. You may want to modify the next sequence number.

Cause: No more sample files can be created using the currently entered file name
sequence number.

Action: Go to Options > Default Method, then enter another sequence number.

2502 The file name must contain a $ character.
Cause: An error occurred in the file being written to during a print operation.

Action: Ensure there is sufficient space on the drive containing the file.

2506 Sample file [n] has a No Analysis status and cannot be used for this operation.
Cause A: Aninternal processing error has occurred.
Action A:  Contact your Micromeritics Service Representative.
Cause B: The selected output device is not installed.

Action B: Select a different output device.

2507 The sample has an invalid status and cannot be used for degassing.
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Cause: An attempt was made to degas a sample that has a status other than No Analysis.

Action: Select a sample with a status of No Analysis.

2508 The selected file [n] does not contain a valid script.

Cause: The selected service test file does not contain any steps or the file has become cor-
rupted.

Action: If the service test file has no steps, open the service test file and add steps to the file
using the Service Test Script tab.

2513 Unable to read the calibration file [n].
Cause: An invalid calibration file was selected or cannot be read.

Action: Ensure the media containing the calibration file has no problems.

2514 Unable to write the calibration file [n].
Cause: An attempt to save calibration data has failed due to possible media problems.

Action: Ensure the destination location has no problems or choose an alternate media to
save the calibration data.

2518 Analysis data are not suitable for smoothing. Smoothing has been disabled.

Cause: The Analysis data contains volume adsorbed values that are less than or equal to
zero.

Action: No action required; this is a status message only.

Entered or merged data must have at least two points with unique mass percent

2519
values.

Cause: Entered or merged data with less than two data points cannot be smoothed. This
message may refer to the number of points in the repeat analysis if it is selected for
reporting.

Action: No action required; this is a status message only.

2520 No data points available for reporting.

Cause: The selected sample file does not have collected data and cannot be used for
reporting.

Action: Select a different sample file.

Error Messages - AccuPyc i
— Apr 2023



[M] micromeritics’ ErorMessages

2521 Unable to program controller.
Cause: A hardware malfunction has occurred.

Action: Contact your Micromeritics Service Representative.

2522 Invalid controller application file.
Cause: The application’s control file has been corrupted or deleted.

Action: Reinstall the analysis program.

2523 Programming the controller failed.
2524 CRC check failed on programming controller.
2525 Unknown error programming controller.
2526 Controller download was not successful.
2527 Controller CRC error on boot block.
2528 Controller DRAM error.
2529 Controller Com 1: error.
2530 Controller Com 2: error.
2531 Controller debug port error.
Cause: An internal processing and/or hardware error has occurred.

Action: Contact a Micromeritics service representative if this error message continues.

2532 The instrument contains a different software version. Do you want to reset it?

Cause: The application has discovered a different version of application operating in the
analyzer.

Action: If there are no analyzers other than the one connected to the computer, click Yes,
then allow the updated application to load.

2533 Analyzer initialization failed.
Cause: An internal processing and/or hardware error has occurred.

Action: Contact your Micromeritics Service Representative.

2534 Unable to establish the TCP connection with [n].

2534 Unable to establish the TCP connection with the instrument.
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Cause: There was a problem establishing communication with the analyzer.
Action: Ensure that the communications cable is seated firmly in the Ethernet slot at the
analyzer connection and the computer connection.

Ensure that no other Micromeritics application is initializing another analyzer. If
there is another Micromeritics application open and initializing an analyzer, wait
until the analyzer initialization completes or is canceled.

Contact a Micromeritics service representative if this error message continues.

The file [n] could not be written. Check that the directory permissions are cor-

2542
rect.

Cause: The person logged into the computer does not have write access to the program
and/or data directory.

Action: Contact your system administrator set up proper privileges for all users

2548 System status 1 [n].
2548 System status 2 [n].
Cause: There was a problem establishing communication with the analyzer.

Action: Ensure that the communications cable is seated firmly in the Ethernet slot at the
analyzer connection and the computer connection. Contact your Micromeritics Ser-
vice Representative.

2549 Error accessing online manual file [n].
Cause: The Operator Manual file could not be located.
Action A: Reinstall the application.

Action B: Copy the contents of the manual folder from the setup media to the application dir-
ectory.

2551 Cannot access web page [n].

Cause: The Micromeritics web page for DFT models cannot be accessed. This could be
caused by an ISP problem of high internet traffic.

Action: Try the operation later.

2552 Configured serial number does not match instrument.
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Cause: An analyzer was substituted without properly changing the analyzer serial number.

Action: Use the installation program to add or move devices as necessary.

2553 Dialog ID [n] can not be created.
Cause: A required window could not be found by the application.

Action: Re-install the application.

2554 File [n] does not contain any report data.
Cause: The selected sample file has no reports selected for printing.

Action: Edit the sample file and select reports to print in Report Options.

2556 File [n] cannot be opened. It is currently selected for analysis.
Cause: The sample file is currently selected and is undergoing a critical operation.

Action: Open the sample file after the critical operation has completed.

2557 Directory [n] does not exist.
Cause: The directory entered in a file selector is not valid.

Action: Enter a valid directory.

2558 The instrument is busy. The requested operation cannot be executed.
Cause: The analyzer is analyzing and cannot be interrupted.

Action: Try the operation later.

2560 File [n] cannot be created or opened. It has an unrecognized extension.
2560 File [n] cannot be created. It has an unrecognized extension.

Cause: The extension specified in the file you are trying to create is not one which is recog-
nized by the application.

Action: Change the extension of the file in the file name field of the file selector.

2563 Cannot write. File or directory [n] read only.
Cause: The specified file name is marked as read-only

Action: Select a different file name.

Error Messages - AccuPyc i

— Apr 2023 1



Error Messages EI micromel‘iti05®

2564 Directory database [n] error [n].
Cause: There is a problem creating the directory file used in file selectors.

Action: Verify the directory specified in this message is not marked read-only.

2570 Instrument log database could not be opened: [n]
2571 Instrument log database [n] error [n].
Cause: There is a problem opening the analyzer log file [SN.LOG].

Action: Exit the application. Go to the \HARDWARE subdirectory of the analyzer 's pro-
gram directory and rename the [SN.LOG] file where SN is the serial number of the
analyzer . A new log file will be created.

2572 File [n] already selected for the analysis.

Cause: The file selected for analysis on one port has already been specified for another
port.

Action: Select a different sample file for each port.

2573 A maximum of [n] files may be selected.
2573 A maximum of [n] files may be selected for analysis.

Cause: When using one file selector to select samples for all ports, the number of samples
selected exceeds the number of ports on the analyzer.

Action: Select the proper number of samples or pick the sample for each port individually.

2574 No samples, entered samples, or completed samples selected.

Cause: When using one file selector to select samples for all ports, either no samples were
selected or a file with Complete status was selected.

Action: Select samples that do not have a Complete status.

The application is running an analysis of which the instrument is unaware. The
2575 analysis will be restarted and canceled to ensure that the instrument is in a safe
state.

Cause: The analyzer was power cycled or rebooted during an analysis.

Action: Allow the termination to complete and run the analysis again.

2576 The instrument [n] is not calibrated.
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Cause: The analyzer application is in the process of initializing the analyzer and is unable
to locate the calibration files.

Action A: Click OK. Go to Unit [n] > Calibration > Load from File, then select a file con-
taining calibration data.

Action B: Click OK. Close the application, then use the Setup program to reinstall calibration
files.

2577 The python directory is missing or some of its contents have been removed.
Cause: When using Advanced reports, a necessary component is missing.
Action: Re-install the application.

Not enough available resources. Application will have reduced functionality.

2578 Reduce the number of open files or report windows.
Cause: There is not enough memory available to open the requested window.

Action: Close any unnecessary applications, then try the operation again.

The selected file has a status that is not compatible with the operation reques-
ted.

Cause: The selected sample file cannot be used for the selected operation. For example, a
sample file with a Complete status cannot be used for analysis.

2579

Action: Select a different sample file.

2584 The application encountered an unexpected error and will be halted.
Cause: :Files necessary for the application are missing or have been corrupted.
Action: Re-install application.

Please re-install to make use of Windows libraries for file management. The fol-

2585 - . . .
lowing libraries are missing: [n]

Cause: This message is triggered on application start up if any of the library files used by an
application do not exist on disk.

Action: Add the library into the libraries folder.

2586 Sample file [n] has no pressure table entries.

2587 Sample file [n] has no dose increment table entries.
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Cause: Trying to analyze a sample file with no pressure entries in Analysis Conditions.

Action: Either edit the Analysis Conditions and enter the pressure points to be used for ana-
lysis, or select a sample file that already has the pressure points entered.

2588 Sample file [n] is a [n] file and can not be analyzed on this instrument.

Cause: The specified sample file is from another Micromeritics application which is not
usable with this application.

Action: Select a different sample file.

2589 Sample file [n] can not be analyzed on this instrument.
Cause: The file specified for analysis cannot be used.

Action: Select a different file.

2590 The default sample file [n] cannot be selected.
2590 The default sample file [n] can not be overwritten.
2590 An error occurred accessing file or directory [n].

Cause: The default sample file (default method) cannot be used in this operation (e.g., as a
sample file for analysis).

Action: Select a different sample file from the data directory.

2591 Cannot open problem diagnostic data save file: [n].

Cause: The file necessary for Unit [n] > Diagnostics > Schedule Diagnostic Test (\Hard-
ware\probdiag.dat) could not be read. It is likely corrupted.

Action: Exit the application. Delete or rename the file mentioned in the error message and
restart the application. A new file will be created.

2592 The selected file has an extension that is not supported by this operation.
Cause: The selected file does not have a supported file extension.

Action: Open the adsorptive properties file. Open the .FPI file selector and select another
file with a supported file extension.

Warning: The selected file uses Unicode (UTF-8 or UTF-16LE) encoding with

2593 non-ASCII characters.

2594 The selected file uses Unicode [UTF-16BE or UTF-32) encoding and could not
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be read.
Cause: The Advanced report is not saved in ASCII format, which is required by Python.
Action: Edit the file and save it in ASCII (ANSI) format.

2595 The selected file is too large (maximum allowed size is [n]).
Cause: The Advanced reportis too large.

Action: Edit the file and reduce the size.

2596 Can not find a file selected for analysis: [n]

Cause: A sample file for a currently running analysis was moved or deleted while the applic-
ation was closed.

Action: The analysis may not complete correctly. If this occurs, close the application and
cycle power on the analyzer using the analyzer power switch. Contact a Micro-
meritics service representative if this error message continues.

2607 Default sample file [n] is invalid. Try deleting it and restarting the application.
Cause: The default sample file is invalid.

Action: Delete the default sample file from the applications directory and restart the
application.

2608 Default sample file [n] is not writable. Program will terminate.
Cause: The default sample file has been set to read only.

Action: Disable the read only setting from the default sample file or delete the default
sample file from the applications directory and restart the application.

Preview data has been truncated due to length. Consider exporting directly to a
printer or to a text, PDF, or XML file.

Cause: A preview report was produced with a data set that is too large to display.

2609

Action: Export or print the report to see all the data.

2610 Failed to create directory [n].
Cause: Bad permissions for selected directory.

Action: Ensure that permissions on the parent directory of the selected folder match the per-
missions of the installation directory. If they do, contact your Micromeritics service
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representative.

2611 Browsing outside of the configured location is not allowed.

Cause: File browsing is limited to the application directory and custom repository location if
one was specified during installation.

Action: Restrict file browsing to the allowed locations. No user should be able to browse out-
side the installation directory or custom repository location when using the applic-
ation.

2612 File [n] cannot be created by [n]. It is a restricted file type.
2613 File [n] cannot be modified by [n]. It is a restricted file type.
Cause: Confirm Analyst accounts cannot open, create, or modify parameter files.

Action: Use a Confirm Developer account to open, create, or modify parameter files.

File [n] cannot be modified by [n]. An error in the audit trail occurred. Changes

2614 cannot be saved.

Cause: The Confirm sample audit trail could not be written, preventing changes to the
sample file.

Action: Contact your Micromeritics Service Representative.

[n] cannot belong to both the analyst and developer group in order to run this

2615 application. Program will terminate.

Cause: The user attempting to log on to the Confirm application cannot be a member of
both the Confirm developer group and the Confirm analyst group.

Action: In Windows Users and Groups, verify that the user does not belong to both groups.

[n] must belong to the analyst or developer group in order to run this applic-

2616 ation. Program will terminate.

Cause: The user attempting to log on to the Confirm application must be a member of either
the Confirm developer group or the Confirm analyst group.

Action: In Windows Users and Groups, verify that the user belongs to one of the groups.

2617 [n] has been locked out. Please contact your system administrator.

Cause: The user has attempted to log in to the Confirm application too many times and the
user account has been locked.
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Action: Contact your system administrator to unlock the user account.

Application will be terminated due to an error [n] during a password update for

2618 [n]. Please contact the system administrator to change the password manually.

Failed to automatically update password for [n]. Please contact the system

2619 administrator to change the password manually.
Cause: An unsuccessful attempt was made to update the password for the specified user.

Action: Contact the system administrator to change the password manually in Windows
Users and Groups.

Too many environment variables in use. Reduce the number of Windows envir-

2620 onment variables.
Cause: An attempt was made to use too many Windows environment variables.

Action: Ensure the total number of characters in the Windows environment does not
exceed 5120 characters.

Large environment variables found. Remove any environment variables exceed-

2621 ing 2048 characters.
Cause: Environment variables are too large.

Action: Ensure there are no long environment variables.

2622 Critical error [n] encountered. The application may not work as expected.

Cause: An attempt was made to run the Confirm application in a Windows environment
other than Windows 10 Professional or Windows 10 Enterprise or higher.

Action: Run the Confirm application in a Windows 10 Professional or Windows 10 Enter-
prise or higher environment only. If you are already running the required operating
system, contact your Micromeritics service representative.

Application will be terminated due to an error [n] in acquiring a windows cryp-

2623 tographic context.

Cause: An attempt was made to acquire a Windows cryptographic context and the process
failed.

Action: Contact your Micromeritics Service Representative.

2624 Application will be terminated due to an error [n] in generating a random pass-
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word.

Cause: The Confirm application failed to generate a random password for the specified
user.

Action: Manually create a password in Windows Users and Groups.

Application will be terminated due to an error [n] in acquiring a windows cryp-

2625 tographic service context.

Cause: An attempt was made to acquire a Windows cryptographic service context and the
process failed.

Action: Contact your Micromeritics Service Representative.

2626 Could not retrieve logged in username or domain.
Cause: The installation process failed.

Action: Reinstall the Confirm application by using the default installer options. Contact a
Micromeritics service representative if this error message continues.

2627 Error opening communications port for the balance.
Cause: Serial communications with a balance could not be established.

Action: Ensurthe cable is attached the balance and the computer. Ensure the balance is
powered on and that the settings in Options > Configure Balance are correct

2628 Incorrect password for [n].
Cause: An incorrect password was entered when an attempt was made to start an analysis.

Action: Re-enter the correct password.

The application controller [n] must not belong to either the analyst or developer

2629 group in order to run this application. Program will terminate.

Cause: The application controller was placed in the analyst or developer group (or both).

Action: Remove the application controller from the group(s).

2630 Failed to get user account information [n].

2631 Failed to acquire credentials handle [n].

2632 Failed to initialize security context [n].

2633 Failed to complete authorizing token [n].
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2634 Unsupported operation to authorize token [n].

2635 Failed to accept security context [n].

2636 Cannot log in as a guest. [n]

2637 Application will be terminated due to an error [n] in decryption.
2638 Error handling new user credentials [n].

2639 Error handling password expiration [n].

2640 Timeout error [n].

Application will be terminated due to an error [n] in initializing the controller pro-
cess.

2644

Cause: Referto the error code provided.

Action: Contact your Micromeritics Service Representative.

2649 The models cannot be located in the models folder. Re-install the software.

Cause: The models could not be located. They may have been inadvertently deleted or
moved.

Action: Reinstall the application.

An error occurred while loading the application control information. Data entry

4200 cannot be performed. (Code [n]).

Cause: An error occurred accessing the control information disk file required by this applic-
ation.

Action: The disk drive may have failed or be corrupt. Run diagnostics on the disk drive.

Total solids concentration is invalid; liquid density is greater than or equal to

5000 solids density.

Cause: The solids density must be greter than the liquid density to calculate total solids con-
centration.

Action: Check that the densities entered in the Material Parameters editor are correct.

6110 Error accessing the sample information file [n].
Cause: There was an error opening a file.

Action: Code 5: There is a problem with the computer login permissions. Consult your IT
department.
Code 2: File not found. Select a different file name.
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6120 Unable to read the calibration file [n].
Cause: The selected calibration file is not valid or cannot be read.

Action: Ensure the media containing the calibration file has no problems.

6121 Unable to write the calibration file [n].
Cause: An attempt to save calibration data has failed due to possible media problems.
Action A: Confirm the media containing the calibration file has no problems.

Action B: Select an alternate media to save the calibration data.

6122 File contains calibration data for a different unit [n].
Cause: A calibration file from a different unit was loaded.

Action: Load a file for the current unit or go to Unit > Calibration and select the appro-
priate menu item.

6123 The device has no calibration data for the selected insert.
Cause: A calibration report was produced for an insert that has not been calibrated.

Action: Perform a volume calibration for the insert or produce a report for a different insert.

The cell and expansion volumes must be positive. Enter positive values and

6126 recalibrate.

Cause: According to the calibration data, the cell volume or expansion volume for the selec-
ted insert is zero or a negative value

Action: Perform these steps:

1. Select Setup > Calibration Data.

2. Inthe Cell volume field, enter the volume of the sample cell (or insert).
3. Inthe Expansion volume field, enter half of the sample cell volume.

4. Perform a volume calibration.

The entered calibration volume is < 10% of the cell volume. The resulting cal-

6127 ibration may be inaccurate.
Cause A: An incorrect volume was entered for the calibration standard.
Action A: Correct the volume entry.

Cause B: The calibration standard is too small for the cell.
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Action B: Use alarger calibration standard.

6160 Device in recognizable state. Analysis canceled.

Cause: The application was closed during an analysis. When the application was restarted,
the analysis had been canceled.

Action: None required. The data collected up to the point of cancellation is saved in the
sample file.

6161 The sample file [n] is already present in the sequence.
Cause: An attempt was made to insert an existing file into the Sample File list.

Action: None required. The same file cannot be inserted into the list multiple times.

6162 The sequence list is full.

Cause: An attempt was made to add another file to the Sample File list for sequenced ana-
lyses when the list already contains eight entries.

Action A: Run the sequence analysis with the current list and include the preferred file in the
next sequence analysis.

Action B: Remove one of the files from the list, then add the preferred file.

6163 The sample file has an invalid status and cannot be used for analysis.
Cause: A sample file with a status other than No Analysis was selected.

Action: Select a sample file that has not been used in an analysis.

6164 FoamPyc analyses cannot be done on a 1 cm? unit.

Cause: An attempt was made to perform a FoamPyc analysis on a unit that does not sup-

port it. FoamPyc analyses cannot be performed on a unit with a 1 cm3 or 2L sample
cell.

Action A: Start the analysis on a different unit.

Action B: Close the analysis window, open the sample file, and select Standard Method.
Then restart the analysis.

6165 Failure to fill sample cup.

Cause: There was insufficient pressure to allow filling within five minutes during an ana-
lysis.
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Action: Increase the regulator pressure or, if there is insufficient helium in the tank, obtain a
new tank of helium.

6166 Pressure overrange.

Cause A: A pressure overrange occurred during an analysis because the regulator pressure
is set too high.

Action A: Adjust the pressure so that it is equal to the higher of the two fill pressures specified
in the analysis parameters plus 2.0 psig.

Cause B: A pressure overrange occurred during an analysis because an error occurred in the
pressure measurement electronics.

Action B: Contact your Micromeritics Service Representative.

6167 Pressure underrange.

Cause: A pressure underrange occurred during an analysis because an error occurred in
the pressure measurement electronics.

Action: Contact your Micromeritics Service Representative.

6168 Pressure failed to equilibrate.
Cause A: The sample being analyzed failed to equilibrate in 1000 seconds.

Action A:  Check the system carefully for leaks following the instructions in the analyzer Oper-
ator Manual. Ensure the sample is properly prepared before performing an ana-
lysis.

Cause B: Sample (foams, organics, etc.) absorbs helium slowly.

Action B: Set the equilibration rate to progressively higher values until reasonable equi-
libration times (15 sec to 120 sec) are achieved.

6169 The instrument lost power during analysis.

Cause: A power failure occurred and when power resumed, the automatic operation was
canceled.

Action: Restart the automatic operation.

6170 The measured volume is < 10% of the cell volume. Results may be inaccurate.
Cause: Not enough sample was placed in the sample cup to give an accurate reading.

Action: Rerun the sample using enough material to occupy the maximum amount of the
nominal cell chamber volume
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6171 Valve failed to respond.
Cause: The analyzer valves failed to operate.

Action: Contact your Micromeritics Service Representative.

At least one report item must be selected. Press Cancel if you do not want a

6200 report.
Cause: No reports were selected in the Selected Reports list. No output could be produced.

Action: Ensure that at least one report is selected for the sample and re-submit the sample
for reporting, or click Cancel.

6201 No data available in [n] for reporting.
Cause: The requested report file does not contain collected data.

Action: Use the file in an analysis before requesting reports.

6202 Total solids concentration is invalid; liquid density is greater than or equal to
solids density.

Cause: Areport was requested on a file containing invalid densities for Total Solids Con-
centration.

Action A: Specify appropriate densities for liquid and solids.

Action B: Do not request that total solids concentration be reported.
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ERROR MESSAGES FOR KEYPAD

press CLEAR. Messages that are not cleared will remain in the queue until the next
analysis or calibration is performed; at that time, any remaining messages will be
cleared automatically.

/ Press CHOICE to cycle through the messages and data. To delete the message,

= NN = Number of cycles completed
m 77 = Number of cycles requested

Add Unit

Cause A: A new analysis module has been attached to the instrument where previously a dif-
ferent module had been attached.

Action A: Press Choice and select Yes to add the new analysis module.
Cause B: Anincorrect serial number was read by the analysis module.

Action B: Press Choice and select No to use the serial number and calibration information
stored in the command module. Contact a Micromeritics service representative if
this error message continues.

ANLSERR: Eq failure — NN/ZZ cycles completed

Cause A: The sample being analyzed failed to equilibrate in 1000 seconds.

Action A: Check the system carefully for leaks following the instructions in the instrument

Operator Manual. Ensure the sample is properly prepared before performing an
analysis.

Cause B: Sample (foams, organics, etc.) absorbs helium slowly.

Action B: Set the equilibration rate to progressively higher values until reasonable equi-
libration times (15 sec to 120 sec) are achieved.
ANLSERR: Fill failure — NN/ZZ cycles complete
Cause: There was insufficient pressure to allow filling within five minutes during an analysis

Action: Increase the regulator pressure or, if there is insufficient helium in the tank, obtain a
new tank of helium.

ANLSERR: Overrange — NN/ZZ cycles completed
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Cause A: A pressure overrange occurred during an analysis because the regulator pressure
is set too high.

Action A: Adjust the pressure so that it is equal to the higher of the two fill pressures specified
in the analysis parameters plus 2.0 psig.

Cause B: A pressure overrange occurred during an analysis because an error occurred in the
pressure measurement electronics.

Action B: Contact your Micromeritics Service Representative.
ANLSERR: Underrange — NN/ZZ cycles completed

Cause: A pressure underrange occurred during an analysis because an error occurred in
the pressure measurement electronics.

Action: Contact your Micromeritics Service Representative.

Automatic operation has been canceled

Cause: The automatic operation has been canceled.

Action: Wait for the termination process to complete or end the termination process by
pressing Alt + CLEAR two more times.

CAL_ERR: Reset Pressure Cal. ?

Cause: The calibration information could not be read from the command or analysis mod-
ule.

Action A: Select Yes and press Enter to reset the pressure and temperature calibration to
nominal values. Resetting to nominal may restore normal readings but a proper cal-
ibration should be performed by a service technician.

Action B: Select No to avoid resetting the calibration. The instrument will be unresponsive.

CAL_ERR: Temperature Calibration Failed

Cause: The temperature calibration was unsuccessful.

Action: Contact your Micromeritics Service Representative.
CAL1ERR: Eq failure — NN/ZZ cycles complete

Cause: The empty cell chamber failed to equilibrate in 1000 seconds during the first pass of
calibration.
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Action: Check the system for leaks.

CAL1ERR: Fill failure NN/ZZ cycles completed

Cause: There was insufficient pressure to allow filling within five minutes during the first
pass of calibration.

Action: Open the tank valves if shut, increase the regulator pressure or, if there is insuf-
ficient helium in the tank, obtain a new tank of helium.

CAL1ERR: Overrange — NN/ZZ cycles completed

Cause A: A pressure overrange occurred during the first pass of calibration because the reg-
ulator pressure is set too high.

Action A: Adjust the pressure so that it is equal to the higher of the two fill pressures specified
in the analysis parameters plus 2.0 psig.

Cause B: A pressure overrange occurred during the first pass of calibration because an error
occurred in the pressure measurement electronics.

Action B: Contact your Micromeritics Service Representative.
CAL1ERR: Underrange — NN/ZZ cycles complete

Cause: A pressure underrange occurred during the first pass of calibration because an
error occurred in the pressure measurement electronics.

Action: Contact your Micromeritics Service Representative.
CAL2ERR: Eq failure — NN/ZZ cycles completed

Cause: The calibration standard failed to equilibrate in 1000 seconds during the second
pass of calibration.

Action: Check the system for leaks.

CAL2ERR: Fill failure — NN/ZZ cycles completed

Cause: There was insufficient pressure to allow filling within five minutes during the second
pass of calibration.

Action: Open the tank valves if shut, increase the regulator pressure or, if there is insuf-
ficient helium in the tank, obtain a new tank of helium. (Tank pressure should be at
least 200 psi above regulator pressure.)
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CAL2ERR: Overrange — NN/ZZ cycles completed

Cause A: A pressure overrange occurred during the second pass of calibration because the
regulator pressure is set too high.

Action A: Adjust the pressure so that it is equal to the higher of the two fill pressures specified
in the analysis parameters plus 2.0 psig.

Cause B: Adjust the pressure so that it is equal to the higher of the two fill pressures specified
in the analysis parameters plus 2.0 psig.

Action B: Contact your Micromeritics Service Representative.
CAL2ERR: Underrange — NN/ZZ cycles completed

Cause: A pressure underrange occurred during the second pass of calibration because an
error occurred in the pressure measurement electronics.

Action: Contact your Micromeritics Service Representative.
DATA_ERR: Chamber volumes must be > 0

Cause: According to the calibration data, the cell volume or expansion volume for the selec-
ted insert is zero or a negative value

Action: Perform these steps:

1. Select Setup > Calibration Data.

2. Inthe Cell volume field, enter the volume of the sample cell (or insert).
3. Inthe Expansion volume field, enter half of the sample cell volume.

4. Perform a volume calibration.

DATA_ERR: No data to compute

Cause A: An automatic operation was canceled before a complete cycle could be completed.
Action A: Restart the automatic operation.
Cause B: All the cycles have been excluded in review mode.

Action B: Return to review mode and include some cycles.
DTA_WRN: Cal std — 10% of full-scale

Cause A: You entered a value for the calibration standard that was less than 10% of the nom-
inal cell chamber volume. Resulting data may be inaccurate.
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Action A: Be sure you enter the value recorded on the Calibration Standard case.
Cause B: You used an inappropriate calibration standard for the nominal cell chamber.

Action B: Use a calibration standard of sufficient size (calibration standards are available
from Micromeritics). The calibration standard should occupy at least 10% of the
nominal cell chamber volume and the more nearly filled the cell is, the better the cal-
ibration.

DTA_WRN: Volume — 10% of full-scale

Cause: There was not enough sample placed in the sample cup to give an accurate read-
ing.

Action: Rerun the sample using enough material to occupy the maximum amount of the
nominal cell chamber volume.

HW_ERR: Calibration could not be read

Cause: The calibration information could not be read from the command or analysis mod-
ule.

Action: Close the application and cycle power on the instrument. Contact a Micromeritics
service representative if this error message continues.

MAN_ERR: Pressure overrange
Cause: Thefill valve was left open until the maximum system pressure was exceeded.

Action: Close the fill valve and open the vent and expansion valves. Allow the pressure to
stabilize.

No A.C. Found

Cause: The control module cannot detect an analysis module.

Action: Contact your Micromeritics Service Representative.

No collected data to report, or all cycles excluded

Cause: You requested areportin which there is either no data available or data have been
excluded via review mode.

Action: Initiate an automatic operation or return to review mode and include at least one
cycle.
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Printer port not responding

Cause: Printer port not responding

Action: Check to make sure the printer is properly connected to the pychometer, is turned
on, and is online.

Queuing print job [ESCAPE] to cancel

Cause: Status message displayed when a report is being printed.

Action: None; this is a status message only.

Reset to factory defaults

Cause: The . (period) key was pressed at startup and the instrument was reset. Data files
and HTML reports have been erased. Setup options have been returned to default
values.

Action: Review setup options.

Sending line (line number) [ESCAPE] to cancel

Cause: Status message displayed when data are being transmitted.

Action: None; this is a status message only.

SYS_ERR: Power Fail — NN/ZZ Cycles Completed

Cause: A power failure occurred and when power resumed, the automatic operation was
canceled.

Action: Restart the automatic operation if desired.

Transmission port not responding

Cause: The receiving device took longer than five seconds to acknowledge receipt of data
from the pycnometer.

Action: Make sure the receiving device is properly connected to the pycnometer RS232
port and is turned on. Verify that the serial I/0O parameters controlling the receiving
device correspond with the data transmission parameters in the set up mode.

Transmission port waiting for Xon
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Cause: The receiving device stopped transmission by sending an Xoff, and hasn’t resumed
the transmission by sending an Xon.

Action: None; when the receiving device is ready for more data, it should send the pycno-
meter an Xon.

TRN_ERR: Timeout failed to respond

Cause: The receiving device took longer than 10 seconds to acknowledge receipt of data
from the pycnometer.

Action: Make sure the receiving device is properly connected to the pycnometer RS232
port and is turned on. Verify that the serial I/O parameters controlling the receiving
device correspond with the data transmission parameters in the set up mode.

Updating Unit [n] failed: Press [CLEAR]

Cause: One of the analysis modules has malfunctioned.

Action: Press CLEAR and follow the instructions displayed in the keypad window. After dis-
connecting the faulty unit (as instructed), you may reconnect the control module
with the remaining analysis module(s) and continue using your system.

USR_ERR: Cal std 10% of full-scale

Cause: You tried to enter a calibration standard volume that is less than 10% of the nominal
full-scale volume.

Action: Enter a volume that represents at least 10% of the nominal cell chamber volume.
USR_ERR: No data to review
Cause: You tried to review data for an automatic operation when there were no data to

review.

Action: Abandon request.

USR_ERR: Number of cycles must be 2 5

Cause: You tried to enable run precision without increasing the number of runs to at least
five.

Action: Increase the number of runs to five or abandon request.
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USR_ERR: Out of range

Cause: You tried to enter a value that is out of the valid range.

Action: Enter a value in the specified range.

USR_ERR: Pressure overrange

Cause: A pressure overrange occurred but was left uncorrected.

Action: Return to manual mode and vent the system.

USR_ERR: Cal std 10% of full-scale

Cause: You tried to enter a calibration standard volume that is less than 10% of the nominal
full-scale volume.

Action: Enter a volume that represents at least 10% of the nominal cell chamber volume.

USR_ERR: No data to review

Cause: You tried to review data for an automatic operation when there were no data to
review.

Action: Abandon request.

USR_ERR: Number of cycles must be 2 5

Cause: You tried to enable run precision without increasing the number of runs to at least
five.

Action: Increase the number of runs to five or abandon request.

USR_ERR: Out of range

Cause: You tried to enter a value that is out of the valid range.

Action: Enter a value in the specified range.

USR_ERR: Pressure overrange

Cause: A pressure overrange occurred but was left uncorrected.

Action: Return to manual mode and vent the system.

Error Messages - AccuPyc i

— Apr 2023 31



	Error Messages
	Error Messages for Keypad



